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Overview
LET’S TALK STATS, DATES & TASKS
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Exxat Stats

 We have been helping clients with their March 15t
Mailing for over four years.

 |n 2017, we assisted 50 schools with their March 15t
Mailing.

* In 2018, we plan on assisting over 80 schools with
their March 15t Mailing.
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Timeline

Your March Mailing isn’t just about March 1t

e January 10t & 11t™: March 1t Mailing Webinar

* January 16™ — February 23™: Schedule Meeting with M1M
Coordinator

* On or Before February 1st: Configure your Save the Date (sent
out by Exxat within 24 hrs of the date/time specified)

* February 25%: Deadline for any slot request changes.

* March 15t Slot Requests sent out by Exxat within 2 hrs of
date/time specified

e March 2nd and beyond: Check Analyze tab for bounce list,
slots, and more
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Slot Request Workflow

We all know that the March 15t Mailing isn’t just about one
task. Here’s what you’ll be doing to get ready!

Schedule
Check your Enter your your Slot
Sites Sessions Request
- - - - - -
Check your Set Up Check your ‘
Staff your Slot Bounce List
Request



Clinical Sites
IS YOUR SITE LIST READY?



Clinical Sites

All active clinical sites are included in the March 1°t
Mailing.

If there are active sites you don’t want to receive slot

requests, make sure you set Include this site during
slot requests? to No by going to Edit Site Information

# Other Configurations

Does this site prefer paper based request? Mo Does this site require special application from students? No
Is this site based in a rural area? Mo Does this site provide services for a medically underserved area or No
population?
Category Nothing selected Show on Map of Affiliation?
Site initiated by -Select- Does this site qualify for reimbursement? No
Does this site precept students from other Mo

programs?

Include this site during slot requests?

Please enter notes to be shared with site during slot request Normal text - Bold ralic  Underline E O E E =



Clinical Sites: Settings

You can set up your sites to offer slots for all settings or
only for the settings they are set up for in your system.

Make sure you have entered accurate data on your
site’s settings.

View and edit settings at Configuration > Advanced
Options > Site Setting
»Use Advanced Search to look for sites missing a
setting
»Use the Green Edit Pencil icon to edit the setting
at a site

aaaaaaaaaaaaa



Clinical Sites: Site Categories

* If you don’t want to send the same slot request to all
sites, you can set up site categories and configure
each request by category.

 Examples might include sites based on location or
based on the type of slot you want (CE1, CE2, etc.)

* To create groups of sites, you will need to have

Support add site categories for you. Please discuss
this in your meeting with your M1M Coordinator.
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Clinical Sites: Useful Tips

* For sites with lots of locations, you might want to
create a new site for the group (like AA Test Site,
Midwest region) and allow the CCCE to add slots for

that general site.
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Clinical Personnel
IS YOUR SITE STAFF READY?



Clinical Personnel

To receive slots, clinical personnel must:
 have accurate contact information
e be associated with at least one site

e Have ‘Include Staff in Bulk Email’ set to Yes
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Clinical Personnel

* Use the Site Staff Report to review which clinical staff
will receive the M1M

 When staff are assigned to more than one site, they
will see the list of all active sites on the same landing
page and receive just one email

e Clinical staff roles (who receives the mailing, who
shows up on the placement, etc.) can be easily
edited in Clinical Personnel
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Clinical Personnel: Review

* Quickly review site staff from the Site Staff Report

e Clinical Personnel > Personnel Reports > Site Staff
Report

Site Staff Report

Instructions: This page displays a list of Site Names, Contract End Dates and corresponding Site Staff.

% Site Staff Report [] Sites with Mo Staff Report

Advanced Search Show 50 4 Records « 4 » »

Filter . Active Sites : rue ¥ Show on Send Slot Request : true ¥ Show Staffs with Email : rue % Include in bulk mailing : true X
ng

&% Notes for Students Jif Motes for School

Site Name “ Contact Info Site Area Contract End Date  Site Staff Notes

Apple Crest Nursing Center . Phone:202-555-0199  InArea 12/31/2020 Gilbert, Jason {jason Gilbert@example.com) =
1922 Water Street, Anaheim, California(CaA)- 32801 Fax: N/A CCCE

Goodwin, Joshua
{Joshua.Goodwin@example.com)

Clinical Instructor

BayHealth Hospital . Phone:562-795-5367  InArea 10/01/2019 Hoffman, David (david.hoffman@example.com) {8k
4150 Chicago Ave, Riverside, CalifornialCA)- 92507 Fax: 202-555-0258 CCCE

Brenner, Lisa (lisa.orenner@example.com)
Clinical Instructor



Clinical Personnel: Editing

TO Set Staff to be i n CI u d ed Edit Staff Information - Jason Gilbert
in the mailing: vesgnaton'

CCCE

Should They Receive Placement Notifications?

e Search Staff > Edit Staff
Information Include Staff in Bulk Email?

Shiow This Staff On Student’s Placement View?

.
¢ Set I n Cl u d e Staff I n Should They Receive Evaluations?

Bulk Email to Yes e

Date for start of relationship

10/2/2017



Sessions
HAVE YOU SET-UP YOUR SESSIONS?
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Sessions

* In order for session to appear on a slot request, they
must be set up.

 Placements > By Session > Add New
By Session

Instructions:

This page displays a list of Session details. Please note that the default is filtered by Active and Favorite Sessions. You may remove the default filters. Click Add Session to add a new Session. You may use Quick Search to

search a specific Session by Session Label, Batch Label and so on.

F_1
=+ Add Session
[—

Tools ~ Quick Search...

Calendar Year Enter Value Session Label
sacve AR ©Yes N

MN/A

Enter Value Batch Label m -Select- -

| Favarite Only <) Clear All

Filter By : Is Active : true % Favorite Only : true %

Session Label Min Weeks Start Date * Calendar Year Batch Label

Session Setup  Placement Post Placement
6 01/0B/2018 2018

Class of 2018 ° ° °
Class of 2018 ° ° °

# Clinical Education 1

+ Clinical Education 2 8 03/05/2018 2018



Sessions

* Give sessions have a clear title! Sites will see titles!
e Enter accurate dates for each session.

* Missing the Calendar Year or Batch you need? Add it
in Configuration.

* Configuration > School Configuration
— Help Document on Adding a new Calendar Year:
https://help.exxat.com/adding-a-new-calendar-year-steps-pt/

— Help Document on Adding a new Batch:
https://help.exxat.com/adding-editing-managing-student-batches-

exxat-steps/



https://help.exxat.com/adding-a-new-calendar-year-steps-pt/
https://help.exxat.com/adding-editing-managing-student-batches-exxat-steps/

Save the Date Email
DON’T FORGET ME



Save the Date Email

* Prepare sites for your mailing by sending a Save the
Date or similar email in advance.

 These emails are great for:
— Updating contact information on bounced emails

— Introducing your partnership with Exxat to your sites (for
newer clients)

— Notifying your clinical partners of any process changes
with your school
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Save the Date Email

* We recommend sending a Save the Date email on or
before February 15 so you have time to view/edit
your bounce list. (Exxat will send this for you!)

* To ensure your Save the Date and slot request emails
are delivered, have your clinical partners put Exxat

emails on their safe list.

* Add noreply@exxat.com and email.amazonses.com

=
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Configuring Your Slot Request
READY, SET, GO!



Configuring Your Slot Request

 We have enhanced the slot request configuration
dashboard to improve your experience and
streamline the process.

* Go to Configuration > Activity Box > Slot Request
Configuration

aaaaaaaaaaaaa



Configuring Your Slot Request

The Slot Request Configuration dashboard shows past
and current slot requests with some new features

* Site View

e Edit

* Schedule Notification
* Analyze

Slot Request Configuration (" velp ]

Instructions: To create a new slot request, click the green Create New Slot Request button. Click Edit to view or edit an existing request. Click Site View to see an example of what the request will look like for your

sites. Click Analyze to view email performance details and reports.

+ Create New Slot Request

March 1st Requests for 2017



Adding a NewSlot Request

e Click ‘Create New Slot Request’

* You can create the request from scratch or copy an
existing request

Slot Request Configuration (" velp ]

H ate a new slot request, click the green Create New Slot Request button. Click Edit to view or edit
sites. Click Analyze to view email performance details and reports.




Basic Configuration

Basic Configuration allows you to enter the basic details
about the slot request.

Basic Configuration [ relp )

© Slot Request Configuration > @ Basic Configuration

Instructions: Enter basic details for your slot request here, starting with the title. Be sure to give each slot request a clear, unigue name such as 2019 Slot Request. When you have completed all details, click Save to go on to Email

Configuration.

Enter a slot request title

BASIC CONFIGURATION TO DO LIST

ar

Select a slot layout for the request

Show only settings available at the individual site?

Set confirmed slots to Active?

Allow sites to offer FCFS slots? ® EMAIL CONFIGURATION
Set up the details for each email
connected to this slot request
Enter FCFS slot instructions for sites:
Send request only to designated group of sites? CONTACT INFORMATION
E v iodesignatedigroup - ®  CONFIGURATION &
d for si . ATTACHMENTS
Enter due date for slot request responses (optional) Set up your contact information and add
instructions and attachments for your
sites
SESSION SELECTION cCheck the box next to each session that would be included in this request.
E) Save & Next
Search:
» Session Information . Dates " "
Select Mame (Sequence) - Duration " Start Date - End Date (Calender Year) * Batch Name N
CohereX - Columbus 2017 (1) - 5.0 Weeks 10/30/2017 - 3/2/2018 (2017) Class of 2015 (Campus XX)

Climical Internship 11 2018 (1) - 3.0 Weeks 112018 - 1/19/2018 (2018) Class of 2019

e B




Email Configuration

Email Configuration allows you to select and edit email
templates related to the slot request.

Email Configuration (" relp ]

© Slot Request Configuration * € Email Configuration »

Instructions: Mow it's time to configure the details of your email. Click Configure Email to set up templates, subject lines, attachments, and more.

EMAIL CONFIGURATION TO DO LIST

Select the type of emails which you would like to send to the sites and select the template required template againts them
P ¥o platere plate ag o  BASIC CONFIGURATION
) o ) ) Set up the basic infarmation for
Select Email Category Description Temnplate CC/BCC Email Actions this slot request
Save the Date An email to sites notl.ﬁ,rmg Alert Site.SaveTheDa & CC: Configure Email
them of your upcoming . BCC:
slot request
v Slot Request An EITIaI_| to sites Alert.5ite.Slot.Reque & CC Configure Email
requesting slots for the - BCC:

selected session(s)

® COMNTACT INFORMATION
Configure Email CONFIGURATION &

Slot Confirmation  An automated email sent Alert.Site.PendingSlo &« CC:

Reminder to when they offer sites BCC: ATTACHMENTS
ChiT e e T Set up your contact infermation
i - ; and add instructions and
Slot An ::_mmmaled email sent Alert.Slte.AnnuaISIPI s CC: Conﬁgure Email b fo .
Acknowledgement | to sites and school whena = m-—-—sro—E—osie BCC: attachments for your sites
from Site site cenfirms an offered
slot

) Save & Next
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Contact Information Configuration
& Attachments

Contact Information Configuration & Attachments allows
you set up what contact details and other information

will appear on the slot request landing page.
Other Configuration (" help )

© Slot Reguest Configuration > € Other Configuration »

Instructions: Enter the contact information and an optional image to be shown on the site view of the slot request.

CONTACT INFORMATION CONFIGURATION & ATTACHMENTS TO DO LIST

BASIC CONFIGURATION

Set up the basic information for this slot
request

@

Share contact information with your sites ?

@ EMAIL CONFIGURATION

Set up the details for each email
connected to this slot request

) Save & Close



Slot Request Configuration Tips

* You can make one-time changes to the template that will be
saved for use with this mailing.

* If you need to make permanent changes to the template, go
to configuration > Advanced Options > Email Template Editor

* You can only add one photo and contact information to the
contact information configuration page.

* Consider adding other team member’s contact information in
the message or additional information sections.
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Configuring Your Slot Request

Once your slot request is configured, use the slot request
configuration dashboard to perform other actions.

View a preview of Make changes to Input the date/time you View your bounce

your slot request your slot request want your slot request  list, slots, reports,
\ l sent \ etc. /
@ & ® ~
Site View Edit Schedule Analyze

Motification



Site View

e Click site view to see what your sites see
e Select the email you want to review

e Make any needed changes

MESSAGE FROM SCHOOL

CONTACT INFORMATION

As we continue to educate the next generation of healthcare professionals, we want to thank you for your role in mentoring our
students. As we plan for the year ahead, we hope that we can continue our partnership with your facility. Please use this form to
enter your availability for clinical experiences. Next to the clinical site name, select “Yes,” “No,” or “Not at this time” to indicate
your availability for the 2019 calendar year. Clicking “Yes” will provide you with the opportunity to select the timeframe,
setting(s), and other information. Choosing “Not at this time” will allow you to select a date after which you would prefer that we

follow up. If prefer to respond in hard copy, a downloadable PDF version is available in the resource section.

Resources: Hardcopy Slot Request Form &  Clinical Instructor Benefits &
Please respond by: 4/1/2018

DO YOU HAVE SLOTS TO OFFER FOR: 2016,2017,2021,2014

Site Location Response
#1PT CIin.iC , * Yes, | have slots to offer &GRS
100 N Main Street, Indiana(IN), 46307,
Not at this time.Please contact me in the
future

No, | don't have slots to offer

Slot Details

Acute Care(Inp) @Confirmed
Clinical Education I(CE - 1, CE - 2),
Lymphedema [fJ] ©confirmed
test session(1),

Aquatic [fJ] @confirmed
Jenns Bridge 1 and 2(1, 2),

Carlos Anguiano
Carlos.Anguiano@example.com
870-429-8455

Manual Therapy [fl] @Cconfirmed
Clinical Education I(CE - 1, CE - 2),
Neuro Rehab (Inp) |ii] @confirmed
Jenns Bridge 1 and 2(1, 2),

Aquatic [fJ] @confirmed
Jenns Bridge 1 and 2(1, 2),



Scheduling & Sending

e Exxat will send your Save the Date and slot request
emails.

* You must give us the send dates and times.

e Exxat will send Save the Date emails within 24 hours
of the date/time specified.

e Exxat will send slot request emails within 2 hours of
the date/time specified.
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Scheduling & Sending: Option 1

* Go to Slot Request Configuration > Email Configuration
e Click the Configure Email button for Save the Date
* Enter the send date and time

& EDIT EMAIL TEMPLATE

Template Mert.Site.SaveTheDate
Recipient(s) Designation Mothing selected
Subject |
Send date 14972018 1:25:15 AM

Email will be sent in one hour of
the time specified

CC



Scheduling & Sending: Option 2

e Or click the Schedule Notification icon on the Slot
Notification Configuration page

e Enter the date and time
Schedule
Motification

Schedule Notification For March 1st Requests for 2017 [ relp )

© Slot Request Configuration > & Send/Schedule Notification »

Instructions: This page displays a list of Site Staff that will be notified for Slots Requests. Please note that the names displayed are after applying various default filters. You may remove the filters to view all Names.

To queue multiple Slot Requests, select required names and click Schedule Request button, To send the queued requests, click Pending Notifications , select required records and click Send, You can view all sent
notifications on clicking Motification History button.

Email Category Description Template Schedule for a later date Action
Save the Date An email to sites notifying themn of your upcoming slot Alert.Site SaveTheDate 1/9/2018 1:25:15 AM Send
request
Last Senton: N/A
Slot Reguest An email to sites reguesting slots for the selected session(s) Alert.5ite.Slot.Reguest.Reminder 1/5/2018 5:00:46 PM
Last S5enton @ 1/5/2018

AT
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Scheduling & Sending

* You must have your slot request configured by
Sunday, February 25th, 2018.

* |f you don’t have it completed and a
date/time specified our team can’t send your
requests.

e After your request has been configured and
scheduled, our team will send your email.

=
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Analyze
View statistics & reports on your request

laa Slot Request Statistics

106 83 4 132

EMAILS LINKS EMAILS SLOTS

EMAILS BOUNCED REPORT TOTAL SLOTS OFFERED REPORT

EMAILS SENT REPORT LINKS CLICKED REPORT

Emails Sent Report for Exxat Slot Requests 2019
Ll Analyze > Emails Sent >

Instructions: This report shows a list of all recipients who were sent a slot request email.

Please note: not all sent emails are read by their recipients. Emails that go into a spam folder will show as sent. Click on View Sites to view associated sites.

Advanced Search v Show 50 4 Records « < > »

First Name 4 Last Name Phone Email Address No. Of Email Sent Associated Sites
Abraham Aaron 3234427712 gupta.sapna@exxat.com 62
Adam Allan 323-999-1559 aarti.vaishnav@exxat.com 1



Analyze

View additional
reports

lu  Slot Request Reports

AW Call Later For Slots @

Sites who have not responded @
to slot request

Sites who have not offered slots 9

Slots processed in another 0
location

Manage FCFS slots 9
Pending/Cancelled site slot list o

EI8 Interview required slots 0

.
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M1M Coordinator

HELLO, MY NAME IS...



Introducing Your M1M Coordinator

Your M1M Coordinator is Sierra Rome. She works out of LA and will
assist you with any questions regarding your March 15t Mailing.

* Schedule a meeting with her by
visiting:
https://calendly.com/sierra-rome

* Email: sierra.rome@exxat.com

 Phone: (747) 272-7259



https://calendly.com/sierra-rome
mailto:sierra.rome@exxat.com

Next Steps
JUST KEEP GOING!



Next Steps

e Schedule an appointment with Sierra Rome

* |If your school has unique requirements, schedule
your appointment sooner rather than later.

* Visit our Help Center for helpful documents related
to the M1M Mailing. https://help.exxat.com

e Ask Sierra or Beck for help along the way!
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https://help.exxat.com/

Next Steps

e Attend our upcoming M1M webinars:
—1/24/18 M1M Save the Date Emails
— 2/15/18: M1M Configuration & FCFS Management

— 3/7/18: Slot Management 101
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Thanks & Survey

PLEASE FILL OUT OUR SURVEY AND LET US KNOW
HOW WE DID TODAY!
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